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BACKGROUND

« You are an actuary for Bruin Health Insurance, LCC, a Los Angeles based company
insuring personal health claims in Southern California

« Prior fo your team'’s analysis of coverage and reserves, you notice that the policy data is
not formatted in the desired manner

« Each membership is only listed once, regardless of how many times it has been renewed

« Problem: You need to be able to identify the specific 1-year term you're looking at when
conducting the analyses
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BACKGROUND

Task: Update the way the company’s data is stored

« If a membership has been renewed twice (i.e. it was in force for 3 terms), there should
be 3 rows, one for each term

« The listed start date should be the start date of each term (i.e. a new row is created
upon renewal)
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1) Write a VBA macro to accomplish this task with the short excerpt of data

2) Then, once you've ensured the macro works correctly, run it on the full set of
membership data, splitting the 13,041 membership plans into 39,215 rows
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OUR GOAL

MemberlD MembershipStart AvgAnnualClaims MedicalPlan

P100458 3/17/14 $964.82 HMO
P100458 3/17/15 $964.82 HMO
P100458 3/17/16 $964.82 HMO
MemberlD MembershipStart NumberOfTerms AvgAnnualClaims MedicalPlan Eig:i:i E;i:ﬁig :222:: :mg
P100458 3/17/14 3 $964.82 HMO 105944 9/15/18 $692.34 HMO
P105944 9/15/16 3 $692.34 HMO P108055 9/21/17 $516.26 PPO
P108055 9/21/17 5 $516.26 PPO P108055 9/21/18 $516.26 PPO
P108257 10/24/17 2 $696.74 HMO P108055 9/21/19 $516.26 PPO
P108429 11/20/17 1 $533.93 POS P108055 9/21/20 $516.26 PPO
P108776 1/15/18 2 $276.34 PPO P108055 9/21/21 $516.26 PPO
P108873 2/2/18 2 $786.09 HMO P108257 10/24/17 $696.74 HMO
P111792 6/14/19 2 $316.17 POS P108257 10/24/18 $696.74 HMO
P108429 11/20/17 $533.93 POS
P108776 1/15/18 $276.34 PPO
P108776 1/15/19 $276.34 PPO
P108873 2/2/18 $786.09 HMO
P108873 2/2/19 $786.09 HMO
P111792 6/14/19 $316.17 POS
P111792 6/14/20 $316.17 POS
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WHAT IS VBA®?

« VBA stands for Visual Basic with Applications
« Closely related to Microsoft’s Visual Basic
« Object-based language (similar to object-oriented languages)

« Used in Excel to simplify repetitive or complex tasks

LY I i LY
BRUIN ACTUARIAL SOCIETY




ENABLING THE DEVELOPER TAB

Customize
Ribbon

PO I
Ewcel Options k4
Genera

Ferrnulas
Data

Proofing

Save

Lamguage

Ease of Access
Advanced
Customize Ribban

Quick Access Taa

Add-ins

Trust Cemter

& Customize the Ribbon.
L5

Choose commands from:

Papular Cormemands

T Acd or Remove Filters
ol Al Chant
Borders

Yo

g Caloulane Mow
Center
Ciond

tiamal Formatting
Capy
Custom Sort

Cut

Decrease Fant Size

%
:
z
Iy
e
v .
Pl

I« F

Font Color

Font Size

Farmat Cells
Format Painter
Freeze Panes

! norease Font Size
= Insert Cells_.

X Insert Function

o Insert Ficture

nsert Sheet Columns
% Insert Sheet Rows
[T] Insert Table

B hidereer

=
[

=
[

Customize the Ribbon

Mlain Tabs

]
] &

ot

Page

Formulas

=
& EEE &

Mey Tab Mesw Group Remafme.
Customizations: Rgset =

Import/Export ™

BRUIN ACTUARIAL SOCIETY




THE VBA ENVIRONMENT

Multiple ways to open the VBA Editor:

1) Go to Developer tab - Select Visual Basic
2) Keyboard shortcut:

«  Windows: Alt + F11

« Mac:Opt+Fll

3) Right-click on a worksheet - Select View Code
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THE VBA ENVIRONMENT

B ® Microsoft Visual Basic - Book1 - [ThisWorkbook (Code)]

ECR = "o | MORON-" 4N~ W% @ | Ln1,coln - & X
MR-

EEL Q=0 =

| _Project - VBAProject X | General) ~| | Declarations) ~|

= =
=& VBAProject (Book1)
=3 Microsoft Excel Objects
) Sheet1 (Sheet1)
&) Thisworkbook
& VBAProject (SaveAsAdobePDF.xlam)

Properties - T i

|ThisWorkbook Workbook

Led ]

Alphabetic ] Categorized |

(Name) 7 | ThisWorkbook Al
AccuracyVersion 0
AutoSaveOn | False

AutoUpdateFrequency 0
ChangeHistoryDuratiol 0
ChartDataPointTrack | True
CheckCompatibility | False
ConflictResolution 1 - xlUserResolution
Date1904 False =
DisplayDrawingObject: -4104 - xIDisplaySha
DisplayinkComments | True
DoNotPromptForConv( False
EnableAutoRecover | True
EncryptionProvider

EnvelopeVisible False

Final | False

ForceFullCalculation \ False

HighlightChangesOnS¢ False = =
st team g as alm == S
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GETTING STARTED

A module is where you can write VBA code

File Home Insert Page Layout Formulas Data Review View Developer  Add-ins Help Team 2 Search
E@é F‘D’ [F@Record Macro (9 '{\C:)}J gé} E‘ﬁ [] Properties E B2 [ Import

== |5 H — = . =N

. ’ f&e3 Expansion Packs [«

Visual Macros B Use Relative References Add- Excel COM Insert Design Vlew EolE Source B

Basic /\ Macro Security ins  Add-ins Add-ins ~  Mode E' Run Dialog =

Code | Add-ins | Controls | XML
F10 ﬁ Microsoft Visual Basic for Applications - Book1 - [Module1 (Code)]
m File Edit View Insert Format Debug Run Tools Add-Ins Window Help
A B y nam

: ! ~d » u a K EFY O B
2: Project - VBAProject EI [(General) ~ | [(Declarations)
3
4| &E Solver (SOLVER.XLAM)
5 | £-&% vBAProject (Book1)
6 =5 Microsoft Excel Objects
77 Sheet1 (Sheet1)
87 @ ThisWorkbook h

] - Syt Type your code here
2 Y e
10
11 Properties - Module1 EI
12| Module1 Module -]
13| Alphabetic | Categorized |
14| (Name) Modulel
15 L
16 ==« |
17 Immediate
18 |
19 |
20 |
21 |

Sheet1

Ready %3

BRUIN ACTUARIAL SOCIETY




GETTING STARTED

cations - Book1 [running] - [Module1 (Code)]

« |tis always a good idea to put Option 5 ot v e o1 o

¥ File Edit View Insert Format Debug Run Tools Add-Ins Window Help

Explicit inthe declarations at the top EE-F s BB IC > 08 EEF > @

Of yo ur mo d U | e Project - VBAProject X| [ Ticenerai <] frest
. Option Explicit
&% Solver (SOLVER.XLAM) Sub Test () Microsoft Visual Basic for Applications X

E- 8% VBAProject (Book1) 5

® Th is -I:O rC es yo U -I-O d e C I O re G | | yo U r E!@ Microsoft Excel Objects End Sub o compie e

B8] Sheet1 (Sheet1)

: - -4 Thisworkbook
VG”G bles é--@ﬁduli oreee ) Variable not defined

ﬂ% Module1

Properties - Module1

« You can either: odvied Modil

| Alphabetic | Categurizedl
| (Name) Modulel

1) Manually type this, or | L |

2) Go to Tools - Options > Check
“Require Variable Declaration”

—— OK — e

[<l[x
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VBA IN MICROSOFT EXCEL

We write subroutines (denoted Sub) to accomplish tasks that do not return values

We write functions to take in inputs and retfurn some output

« VBA objects include workbooks, worksheets, and ranges:
Application.Workbooks(“Book1.xism").Worksheets(“Sheet1”).Range(“Al")

« Objects have properties and methods, the most important of which is:

Range(“Al1”).Value
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VBA IN MICROSOFT EXCEL

2 commonly used methods in VBA: Select and Activate

Select allows you to select one or more objects

Worksheets (“"Sheetl”) .Select

Range ("A1:A3,Cl1:C3,E1:E3"”) .Select

« Activate allows you to select one object. If you already have multiple objects selected, this
allows you to select one object within them.

Range (“"Al”) .Activate

« EXx: You can select a worksheet where you want your code to run and then activate the first
cell in that worksheet that you want to apply changes to.
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SUBROUTINES

* Most of your VBA code will be in subroutines (also called macros)

« Subroutines can be used to perform calculations, change formatting, and copy
and paste among other repetifive tasks

« We enclose our code in the following:

Sub Myroutine ()

End Sub

* In this case, we have named our subroutine “Myroutine ()" (but we can name
this whatever we want)
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SUBROUTINES

We can call our subroutine in several ways:

Clicking “Macros” in the Developer Tab Adding a button or some tool

Macro ? X
Macro name: :l p : Assign Macro 7 »
ropert :
T » = D e
outine oviewc ¥ :
Myroutine Insert Deggn B Button_Click 4 New
Step Into - Run Dii | | Myroutine Al
P Mode (4] F—
Edit Form Controls
EMEE®
Create Ifl Aa B [abl
F ActiveX Controls
Delete
O F vl Bkl B
Options... |i| (®) A I_; - !Y Macros i | All Open Workbooks
Descripton
Macros in: | All Open Workbooks g
Description Cancel
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« Syntax

Function MyFunction (paraml As dtype, param”Z As dtype,..) As dbype
statements
MyFunction = value

End Function

« Ultimately, you assign a return value by setting the name of the function to some value

« These functions can be called from workbook cells, like how you use COUNTIF(),
VLOOKUP(), and other functions
A VO™
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\VNGINORNEI GO D]

« This is the easiest way to “write” a macro

File Home Insert  Page Layout  Formul3

= #Record Macro « Under the Developer tab, click “Record Macro”
= =] = : oV

_ Use Relative References _ . . . .
Yot Macs A Mk secifity gl « Allyour oc;’nons will be ’rronslq’red into codg, which

Code A you can find under Modules in the VBA Editor
Al Record Macro ) ) .
Record a macro. * You can look at and modify this code to suit your
A

1 Each of the commands you B purposes
5 perform will be saved into the
3| g‘;f;z;;;“at il ot « Often slow and clunky, but can be very powerful
4 tool if used right (e.g. no one remembers how to

filter/sort data in VBA, but this tool helps!)
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VARIABLES

Variable types: Integer, Double, String, Boolean, Date, Currency, and more

We use the keyword Dim to declare a variable:
Dim mystring As String
Dim dbl As Double

Dim num As Integer

Note: All highlighted words in
Dim rng As Range sample code are variables that
you can name whatever you want.

We assign them with *="
mystring = “Hello”

num = 5

However, to assign a range, we use:

Set rng = Range (“Al:B3”)
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VARIABLES

« |f the data type is not specified, the variable will be declared as a variant
« A variant can contain any kind of data, and the data type can change at any point

« Try to avoid these if possible (they require a lot of memory)
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ARRAYS

Arrays are created with parentheses to indicate size:
Dim myarray(5) as Integer
« The size can be changed:

ReDim myarray (10)

« But this will delete the data. To preserve the data inside, use:

ReDim Preserve myarray (15)

« Individual elements can be accessed and modified with parentheses:
myarray (0) =5
« There's alot more 1o be learned with arrays, but you can look online for more
details. We'll work primarily with Workbook objects instead.
A O™
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* Syntax

If condition Then
[statements]

[Elself elseifcondition Then
elseifstatements]

[Else
elsestatements]

End If

e |fconditionistrue, runs statements.lf condition isfalse butelseifconditionistrue, runs
celseifstatements. Otherwise, runs elsestatements.

 There can be as many ElseIfs as needed
.- .- N
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« Syntax

While condition
statements
Wend
e Runs statements until condition evaluates fo FALSE.

« Make sure that condition will not be TRUE forever, or you will have an endless while loop
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FOR LOOPS

« Syntax
For counter = start To end [Step increment]
statements
Next [counter]
« Typically, counter is an Integer that we increment
e “For i =0 to 3"willrun4times (1 = 0, 1, 2, 3)
e "“For i =2 to 7 Step 2"wilrun3times (i = 2, 4, 6)

* "For i =5 to 0 Step -3"willrun2times (i = 5, 2)
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FOR EACH LOOPS

Syntax

For Each cell In range
statements

Next

A quick and simple way to loop through all the cells in a range

cell and range must both be Range objects

range should be initialized to some Range, ce11 need not be
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MESSAGE BOXES

* Synfax: MsgBox (“Prompt”) _

Microsoft Excel X

 You canreplace “Prompt” with whatever you want
to appear in a message box

Hello World

« Can be very useful in debugging to display the value
of variables

OK
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DEBUGGING TOOL:

IMMEDIATE Wi

Immediate

« Short lines of code can be run here

x| « You can also ask questions:

?Worksheets.Count

?Range (“B2"”) .Value

L= « If you use Debug.Print inyour code,

the output goes to this window
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WORD OF CAUTION

Once you run a macro, you can’t undo it

Make sure to save your worklbook before running a macro to avoid
losing your work in case the macro doesn't work as intended
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